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Overview of MasterMinder MLC System 
The MLC system utilises a 132kHz communications signal injected onto the mains 
cabling to communicate with the attached emergency luminaires. 

Simple installations communicate between an SCU (Supervising Control Unit) 
directly to the emergency luminaires. 

In normal installations ITUs (Intelligent Transponder Units) are added to facilitate 
communication. The SCU communicates with each ITU via a dedicated cable (see 
figure below). The ITUs utilise the signal injected onto the existing mains cabling to 
communicate with emergency luminaires. These fittings, each of which is uniquely 
numbered during commissioning, can be addressed individually, in groups or as a total 
system. Each fitting, after being addressed, sends data back to the SCU via the mains 
cable and appropriate ITU.  

The MasterMinder software supplied with the system allows the user of an IBM 
compatible computer (PC) running Windows to install, test, and store data on the 
installed luminaires.  

The PC can be connected directly to the SCU by the computer’s serial port, network 
(using a device server) or via a modem and telephone line. 
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SCU operation 

 

The SCU4 (pictured above) and MODEM equipped SCU5 function in a similar 
manner. 

The SCU must be initialised using a computer and the supplied software. The number 
of installed fittings, time and date, and the ITU path for each installed luminaire are 
stored in the SCU. 

Pressing the POLL button causes the SCU to check all fittings installed to locate 
fittings with faulty mains lamps or fittings not communicating. It will display the 
nature of the fault (not found or faulty lamp) for the first faulty fitting found. Pressing 
the POLL button again will enable the SCU to continue polling the remaining fittings. 

The SCU4 will also display when a test is running and the test duration. At the 
completion of a test the following message will be displayed: TEST FINISHED 
RETRIEVE RESULTS. The SCU5 will additionally display REMOTE LINK IN 
PROGRESS when it is being accessed by a remote computer via modem. 
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Installing the MasterMinder PC Software 

User Requirements 
This user manual is written with the assumption that users are familiar with the 
Windows operating environment. The manual does not include instructions on the use 
of screens that are similar to standard Windows screens - such as file open, file save, 
print. 

PC Requirements 
PC running Windows 95, Windows 98, Windows 2000, Windows XP, NT, Vista or 
Windows 7. 

Installation 
The software is supplied on a CD Rom.  

� Ensure that there are no applications running (including MS Office). 

Insert CD into the CD Rom drive. 

Click on START and select RUN. 

Type D:\FAMCO 32BIT\SETUP  (replace D with the CD Rom drive letter) and 
follow the on screen instructions. 

Note:  On some systems you may be required to re-start the Setup programme if the 
Setup programme re-boots the computer during installation. 
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Operating the PC Software 

Introduction 
This manual is applicable to MasterMinder MLC systems with and without a 
MODEM interface. Information relating to MODEM (remote access) operation 
is only relevant to MODEM equipped SCUs. Options relating to remote access 
operations will not be displayed for systems without this facility. 

The MasterMinder SCU operating software allows for connection of the computer 
directly to the SCU or connection via a suitable modem and telephone line. 

The software allows the operator to commission a site and to conduct routine testing 
of the emergency luminaires on the site. Unless suitably trained, operators should only 
utilise commands relating to routine testing. 

Use without a mouse 
In some situations (one serial port without built in mouse/trackball or bus mouse) the 
software may have to operated without a mouse. The menu items can be selected by 
pressing ALT with the underlined letter in the menu name ie. ALT F will select the 
FILE menu. When a pull down menu has been selected and is displayed each item can 
be selected by using the arrow keys or by typing the underlined letter for the option 
that you want to select (without pressing the ALT key). For example, when the FILE 
menu is displayed pressing V will select View File. 

Some frequently used commands in the TEST menu can be invoked by using function 
keys ie. F2 - MANUAL, F3 - COLLECT, F4 - ABORT. 

Logging On 
After selecting and running the MasterMinder software a logon screen appears. Enter 
the password. The default password is ‘FAMCO’. After logging on the system for the 
first time change the password using the Password option in the Setup menu (see Page 
13). 

If this is the first time that the software has been used another screen will appear 
asking for the site location. Type this information in. 

Master Screen 
The following screen is displayed after logging into the system. Several items in the 
SITE DATA section will remain blank until the computer is connected to an SCU, 
either directly or via a modem. Several menu items will not appear or appear dimmed 
until connection with the SCU is made. 
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Master Screen - Site Data 

The Site Data section of the Master Screen provides information about the site that is 
stored in the SCU. 

Connected to The SCU type that is connected, or a modem if connected. 

Site Name The site name that is stored in the SCU. (See Utilities menu) 

Installed Units The start number of the first (From) and last (To) luminaires 
installed. This can be some or all of the luminaires physically 
installed on the site. Physical luminaires with numbers outside 
the range displayed here will be ignored by the SCU. The 
installed units can be changed using the Units option in the Setup 
Menu. 

Installed ITUs The number of ITUs installed. This can be some or all of the 
ITUs physically installed. For example, if there are 4 physical 
ITUs installed on a site and only 3 displayed here then the SCU 
will ignore ITU number 4. The number of installed ITUs can be 
changed using the ITUs option in the Setup Menu. 

Comm. Port The identity of the serial communications port that the SCU or 
modem is connected to. Usually 1 or 2. 

Searching Displays the current searched fitting. 

Time and Date Displays the time and date from the computer (not the SCU). 
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Master Screen  - Menubar 

File Menu 
New: Opens a simple text editor. Text can be typed in or copied from 

another file. Files can be up to 32 kbytes. 

 

View: An existing data file can be opened. MasterMinder data files 
normally have a ‘.dat’ extension and log files ‘.log’. Open files 
can be viewed and edited. 

Save: Saves the result of the previously completed command into a file 
(????????.dat). Typically used after using the collect data 
command to save the resulting information that has been 
displayed on the screen. 

Print: Prints the currently open file. 

Close: Closes the file opened by the VIEW command. 

Open Log: Opens a file (.log) to which data will be logged. Refer to the 
section on logging data for further information. 

Close Log: Closes the data logging file. 

Exit:  Closes the MasterMinder software and returns to Windows. 

Disconnect/Connect 
Selecting Connect will connect the computer to the attached serial device, either an 
SCU or a modem. When connected, selecting Disconnect will disconnect the 
computer from the attached serial device. 

� When changing from one SCU to another as occurs when there are multiple SCUs 
attached by a switchbox it is critical that the DISCONNECT/CONNECT commands 
be used when changing SCUs. 

File 

New 
View 
Save 
Print 
Close 
Open Log 
Close Log 
Exit   Ctrl+X 
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Ensure that the correct serial communications port is selected - this can be changed 
using the Setup option in the Setup menu (see below). 

Direct Connection 

Ensure that the serial cable connects the PC to the serial port on the SCU and that the 
SCU is on. 

Click on Connect in the Menu Bar. The Menu Bar will change Connect to 
Disconnect. 

The Site Data section will be displayed at the bottom of the screen. This is described 
below. 

Connection via Modem 

Ensure that the serial cable connects the PC to the modem and that the modem is on.  

Ensure that the correct serial communications options for the modem are selected - 
this can be changed using the Setup option in the Setup menu (see page 13). 

Click on Connect in the Menu Bar. The Menu Bar will change Connect to 
Disconnect. 

The Site Data section will be displayed at the bottom of the screen. This is described 
on page 7. 

Select the Dial menu (see page 21) from the Menu Bar to connect to the remote SCU. 

� Disconnect to hang up when using a MODEM before dialling up another location. 

Edit Menu 
Cut: Cuts the selected text. 

Copy: Copies the selected text. 

Paste: Pastes the selected text. 

Delete: Deletes the selected text. 

Test Menu 
The Manual, Collect and Abort commands can be accessed by the F2, F3 and F4 keys 
respectively and from the Toolbar. 

Auto Test: Allows a test to be programmed for a user specified time and 
date. The length of the test must be entered. The user can select 
one or more luminaires to be tested. The following menu is 
displayed. 

 
Set Auto Test 
Read Auto Test 
Cancel Auto Test 

Edit 

Cut 
Copy 
Paste 
Delete 

Test 

Auto Test 
Manual F2 
Collect F3 
Auto Collect 
Cluster Utility 
Abort F4 
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Set Auto Test:  The following screen is displayed. 

 

Using the mouse on the screen keypad can be used as an 
alternative to typing in numbers. 

Select Single Unit if you want to test one luminaire only. 

Select Group of Units if you want to test a group of luminaires, 
for example luminaires 5 to 10. The screen changes to allow for 
the entry of the first and last fitting to be tested. 

Select All units if you want to test all installed emergency 
luminaires. 

Enter the unit to be tested or, as previously mentioned, another 
box appears when testing a group of fittings so that you can enter 
the first and last fitting to be tested. 

Enter the duration of the test (in minutes). 

Press OK and the following screen will be displayed. 

 

The time and date for the planned test, displayed in Current 
Setting, can now be entered. Selecting Now will select the current 
date and time from the computer. Selecting 6 Months will place a 
date and time 6 months from the current date and time into the 
current setting. Alternatively any date and time can be set by 
changing the setting in each of the boxes for time and date. Select 
OK and the Auto Test will be displayed on the screen. 

Read Auto Test: Will display the time and date stored in the 
SCU for a programmed test. 
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Cancel Auto Test: Cancels a programmed test. 

 

Manual: Allows for the immediate testing of one or more luminaires for a 
user determined time. Similar to Set Auto except testing is 
commenced immediately. 

Collect: Allows for the collection of test results from one or more 
luminaires. If a luminaire is currently being tested a BUSY status 
will be displayed. 

Auto Collect: Allows for the automatic collection of information from the 
fittings at a user selectable time of day. When the selected time is 
reached the software automatically does a COLLECT on all 
units, followed by a Search for FAULTY UNITS, FAULTY 
LAMPS and FAILED TESTS. The results are stored in a user 
selectable LOG file. This will be done each day at the selected 
time whilst the function is enabled. The log file that contains the 
collected information is overwritten each day. 

 When AUTO COLLECT is selected the following screen is 
displayed. Select the time at which the data is to be collected. 

 Select the Enable button to turn the Auto Collect function on. 
Alternatively, select the Disable button to turn Auto Collect off. 
The status of Auto Collect is shown in the status box at the 
bottom of the screen. When Enable is selected the next screen 
asks for the location of the LOG file that stores the collected 
information. Enter the file name and location and select Open. 

 NOTE: Ensure that the computer is set up so that it does not shut 
down automatically whilst awaiting the time set for the 
AUTOCOLLECT.   

Cluster Utilities: Allows for the testing of ‘clusters’ of fittings. Refer to the section 
on the Fitting Tracker for a description of clusters and how to 
create them. 

� The cluster functions may not operate correctly with SCUs 
containing early version firmware. Contact Famco for 
information about firmware upgrades if this is necessary. 

 Type in the name of the cluster and then select RETRIEVE 
FITTINGS. A list of fittings in the selected cluster will be 
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displayed. Select the operation to be undertaken (START TEST, 
COLLECT DATA, ABORT TEST) and then select BEGIN. 

 

 NOTE: When a test is started using Cluster Utilities the LAST 
TESTED field in the Tracker database is automatically updated 
with the current date for each fitting tested.   

Abort: Allows for tests to be aborted. 

Search Menu 
Faulty Units:  Identifies luminaires that the SCU cannot communicate with. 

Failed Tests: Identifies luminaires that failed their last test. The test results are 
stored in each luminaire until a new test is run. 

Faulty Lamps: Identifies all sustained luminaires with a faulty mains lamp, 
maintained luminaires with a faulty maintained lamp, and 
incandescent luminaires with a faulty lamp. NOTE: To identify 
faulty fluorescent lamps they must be switched on at the time of 
the search.   

Faulty ITUs: Identifies ITUs that the SCU cannot establish communication 
with. 

Clock Menu 
  

Read: Reads the time and date from the SCU. 

Set: Allows the time and date to be set in the SCU. The clock in the 
SCU can be set automatically, using the time and date from the 
PC, or manually. 

Search 

Faulty Units 
Failed Tests 
Faulty Lamps 
Faulty ITUs 

Clock 

Read 
Set        > 



Famco MasterMinder  Page 13 

 

Setup Menu 
These menu items must only be used by trained operators. They are usually only 
required during the system commissioning process.  

Setup: Allows the operator to set up the serial communications port and 
several other options relating to how the software behaves. 

 

Comm Port Select the serial communications port to which 
the SCU or Modem is connected. 

Modem Setup The 9600 bps Modem built in to the SCU5C 
does not support some of the functionality 
provided by high speed Modems. You must 
ensure that the settings on your Modem make it 
compatible with the 9600 bps Modem. An 
initialisation string that often works is “ATZ 
S=0”and “RTS/CTS” handshaking option must 
be selected.  If these do not work refer to your 
Modem manual for the appropriate AT codes to 
connect to a V.32 9600 Bps Modem.  

If an older SCU5 (SCU5,a,b) is being used a 
2400 baud rate must be used and the setup 
string AT&F5 or AT&Q0&K0 must be used as 
well as the “No Handshaking”. If these do not 
work refer to your Modem manual for the 
appropriate AT codes to place the modem into 
asynchronous mode, turn off local flow control 
and turn off error correction. 

Units: Allows the operator to enter the number of luminaires installed in 
the system. 

Setup 

Setup 
Units 
ITUs 
Set Group 
Remote Password 
Main Password 
Drawing Editor 
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ITUs: Allows the operator to enter the number of  ITUs installed in the 
system.  

Set Group: This is normally used if a luminaire has been programmed with 
the incorrect group. The following screen is displayed. Select 
Incandescent for an incandescent luminaire. When a Collect is 
undertaken an N is displayed before the luminaire number.  

 Select Maintained or Non-Maintained when the luminaire has 
one fluorescent lamp (Maintained or Non-Maintained) monitored. 
When a Collect is undertaken an S is displayed before the 
luminaire number.  

 Select Sustained when the luminaire has two fluorescent lamps 
monitored. When a Collect is undertaken a D  is displayed before 
the luminaire number. This is commonly used for a sustained Exit 
luminaire. 

 

Remote Password: This menu item will only be displayed for an SCU5. The SCU5 
must be directly connected to the computer – not via a Modem. 
The remote password must be entered when accessing the SCU5 
via a Modem. To display the current password select ‘Read’. To 
change the password type in the new password and select 
‘Write’. The password can be a maximum of 8 characters. 

Main Password: Use this option to change the password that must be entered when 
starting the MasterMinder software. 

Drawing Editor: Select the CAD drawing program to be used for viewing the 
CAD files showing the fitting locations. For example, AutoCad 
LT , AutoCad or any other graphics application that you use for 
creating or viewing the drawings.    

Utilities Menu 
Site Name: For SCU5 only: Allows the operator to read or enter the site 

name into the SCU. This can only be changed with direct serial 
connection from the computer to the SCU. 

Retries: Allows the operator to set the number of retries. If an SCU does 
not successfully communicate with a luminaire it can keep trying 
(retry) for an operator specified number of times - the number of 
retries is set using this menu option. The number of retries must 
be between 3 and 255. 

Utilities 

Site Name 
Retries 
Continuous Mode 
Font Size 
Clear Screen 
Fitting Tracker 
Site Data 
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Continuous Mode: NOTE: Early version SCU4s and SCU5s do not support this 
function. 

Selection of this menu item allows you to put the system into a 
regular polling mode. CONTINUOUS MODE will be displayed 
on the LCD display together with SYSTEM OK or SYSTEM 
FAULT. SYSTEM FAULT is displayed when polling of the 
system has found a faulty mains lamp(s) and/or faulty fitting(s). 
The SCU4 has a relay (normally closed and normally open 
contacts) that is set when there is a system fault. This can be used 
to interface to a building automation system or alarm. 

On the 3rd, 10th, 17th and 24th day of each month the system will 
be automatically checked (polled). This occurs at midnight. If the 
system is unable to communicate with one or more fittings it will 
try to communicate with them again at 1am. This is automatically 
repeated at 2am and 3am if necessary.  

The SCU will indicate a system fault when appropriate. When 
this occurs you must fix the problem(s). The SCU can be reset by 
doing a manual poll (press the POLL button) – if the system is 
free of faults the SCU will reset to SYSTEM OK and the fault 
relay will be reset. 

Font Size: Set the font size. 

Clear Screen: Clears the current screen. 

Fitting Tracker: This option gives access to a database that can hold key 
information about the MasterMinder emergency luminaires on 
the site. The database is Microsoft Access compatible. The 
following screen will be displayed.  

 

The following definitions are used in the fitting tracker database. 
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Fitting ID Number:  
The unique computer number programmed into the emergency 
luminaire.  

Fitting Number on Drawing:  
The fitting number (which may be different to the Fitting ID 
Number stored in the MasterMinder system) on the building plan 
identifying each MasterMinder luminaire.  

Drawing File: 
The file name and path of the CAD drawing showing the location 
of the fitting. 

Location:  
Enter information describing the physical location of the 
luminaire. 

Catalogue Number:  
Enter the Famco Model Number. A list of standard Famco 
emergency luminaires can be obtained by selecting the arrow at 
the end of the entry box. New model numbers can be added to 
this list. 

Cluster ID: 
Groups or clusters of fittings can be given a cluster identifier that, 
when selected, can be used to put that cluster of fittings into test 
or to collect data. For example, all the fittings in a car park could 
be given a cluster identifier of ‘Car Park’. 

Lamp Fitted: 
The lamp type may be automatically displayed when a standard 
Famco model number is selected. Alternatively, you can select a 
lamp type from the standard list supplied (use the arrow at the 
end of the entry box), or enter another lamp type. 

Series Type: 
Select from the pull down list or enter manually. This field will 
default to the previously selected entry. 

Last Tested: 
Enter the date of the last test. Double clicking the mouse on this 
entry box will enter the current date. Use the UPDATE button to 
enter the current date into all records. 

Hold: 
Selecting this option will give you the option to select Drawing File, Cluster ID or 
Catalogue Number. When selected the entry in the relevant field in the database will 
default to the previously entered value when new database records are added. A � will 
appear next to a field displayed in the menu list that is in HOLD mode. On the EDIT 
FITTING DATA screen a picture of a lock will appear to the left of each field that is 
in HOLD mode. To turn off the ‘hold’ function reselect the relevant field. The HOLD 
function can also be activated by double clicking the mouse button on the relevant 
field name (i.e. Cluster ID) on the EDIT FITTING DATA screen. Repeating this will 
turn off the HOLD function. 

There are 6 forms available in the Fitting Tracker:  

• Edit Fitting Data 

Hold 

Drawing File 
Cluster ID 
Catalogue No. 



Famco MasterMinder  Page 17 

 

• View Database 

• Search for Data 

• Open Database 

• Print 

• Utilities 

You can select each of these by clicking the mouse button when the cursor is on the 
required form name. 

Edit Fitting Data The EDIT FITTING DATA form is shown below. The different 
field descriptions are as described above. This form is used for 
adding or modifying fitting data. Note the ‘lock’ icon next to 
Drawing File and Cluster ID indicating that these are in HOLD 
mode (see above for description of HOLD mode). 

 

The lamp fitted field will be automatically filled when the 
Catalogue Number is selected from the pull down list of standard 
fittings. The current date is entered into the Last Tested field when 
the mouse is double clicked in the Last Tested box. 

The CLEAR button is used to clear the currently displayed form. 

The ADD NEW button is used to create a record for a new fitting. 
The Fitting Number can be automatically incremented for each 
new fitting. Some fields can optionally be held the same as for the 
previous fitting (see above). 

PREVIOUS and NEXT can be used for stepping through the 
records. The order of the fitting records may not necessarily be in 
Fitting Number numerical order. 

The DRAWING button is used to display the CAD drawing 
showing the location of the fitting. The application used for 
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viewing the CAD drawing must have already been selected (refer 
to the SETUP menu for setting the drawing editor application). 
When selected, the CAD file specified in the Drawing File field is 
opened and displayed. 

FIRST FITTING and LAST FITTING move to the last or first 
record respectively. 

View Database The VIEW DATABASE form provides a different means of 
viewing and editing the data. As can be seen below the data is in a 
table format. The order of the fittings as displayed in the table can 
be changed by using the UTILITIES form (see below). 

 

Search for Data The SEARCH FOR DATA form provides a means of finding data 
on specific fittings. Select the field to search, enter the text or 
number that you want to find, select the comparison criteria and 
then click on the BEGIN SEARCH button. The results of the 
search will be displayed on the EDIT FITTING DATA form. 

Note After a search, the fitting tracker data will be limited to the 
results of the search until a REFRESH is done. If a second 
search is undertaken (prior to a REFRESH) then the search will 
only look at the data resulting from the previous search. 
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Open Database The OPEN DATABASE form provides a means of opening the 
database file appropriate to the site or area that is being 
monitored. Enter or select the database file (.mdb) that you want 
and click on the LOAD button. To create a new database enter a 
file name that does not currently exist.  

 

 When an existing database is being loaded you will asked to 
confirm that you want to open the file - select YES to open the 
file. You will also be asked to confirm the creation of a new file. 

 

Utilities The UTILITIES form has 4 functions as follows: 

 Selecting the START COUNT button results in the number of 
database records being counted and displayed. 
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 Selecting the BEGIN REFRESH button results in all database 
records being restored after a SEARCH FOR DATA activity has 
selected out a subset of database records. 

 UPDATE LAST TEST DATE is used to insert the last test date 
into selectable group of fitting records. Select GROUP to update 
a group of fittings with numbers between FROM UNIT and TO 
UNIT. Select CLUSTER to update fittings with a specified 
cluster ID. Select all to update all fittings in the database. To 
enter the last test date into the database for the selected fittings 
select the BEGIN UPDATE button. 

 DATABASE SORT allows you to sort the database records 
according to a user selectable field. Select the field to sort by and 
then select BEGIN SORT. 

 
 
Print The PRINT form provides a means of printing data from the 

fitting tracker database. The information that will be printed is 
limited to the data records displayed using VIEW DATABASE. 

 Each field printed will be printed on a new line. For instance, 
printing the fitting number, drawing number, floor level and 
location will take 4 lines per fitting. The fields to be printed can 
be selected. 

 A more comprehensive printing facility can be obtained by 
accessing the database using Microsoft Access.  
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Site Data: Selecting this option will toggle on/off the site data section at the 
bottom of the master screen. 

 

Dial Menu 
Manual: Only available if using a modem. Connect to the modem using 

Connect/Disconnect before selecting this menu item. The site 
telephone number of the SCU can be entered. The number will be 
dialled when OK is selected. 

Dial 

Manual 
Directory 
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Directory: When selected the following screen will be displayed. 

  

 

 

Site Name: The name of the MasterMinder installation. 
There may be more than one SCU at a site - be 
specific if appropriate. 

Password: The password stored in the SCU. 

Phone Number: The telephone number for the SCU. 

Last Dialled: The date that the SCU telephone number was 
last dialled. 

Address, City, Post Code, State:  
Address details for the site. 

Voice Phone: Telephone number of the person that can be 
contacted on site. 

Voice Contact: Person that can be contacted on site. 

Tracker File: Displays the fitting tracker file for the site. This 
is created by selecting the TRACKER button 
and selecting the appropriate fitting tracker file 
for the site. 

Open a new record 
for another site or 

modem. 

Save the current 
record. 

Dial the telephone 
number displayed in 

phone number. 

Open a window to 
associate a fitting 

tracker file with this 
site. 
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Master Screen - Toolbar 

 

 

 

Open an existing data file. 

 

Save data into a file. 

 

Print. 

 

Copy the selected text. 

 

Cut the selected text. 

 

Paste the selected text. 

 

Open the screen to commence a 
manual test.  

Open the screen to collect data. 

 

Open the screen to abort a test. 

 

Clear the screen. 

 

Provides information about the 
MasterMinder software. 

  

 

 

When the system is set up to log 
data into a file the name of the 
data file will be displayed here. 

 

 
Start logging data to data logging file. 

 
Interrupt logging data to file. 

 
Stop logging data to file and close file (equivalent to Close Log in the File 
menu). 
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Conducting a Test 

When and How to Test 
Testing of emergency luminaires should be done early in the morning when the 
building is unoccupied. This allows for the batteries to recharge during the remainder 
of the night and daylight hours subsequent to the test. 

Testing should be undertaken every 6 months. It is recommended that, although 
routine testing requires a 90 minute period during which the emergency luminaires 
remain on, testing should be of sufficient duration to fully discharge the batteries. A 
test period of  180 minutes should be sufficient. The luminaires should have had at 
least 16 hours to charge following any previous tests. This can be confirmed by 
collecting data from the luminaires and checking that the Charge Rate Unit is float. 

1. Select the Test menu. 

2. Select Auto Test for programming a test in the future or Manual for an immediate 
test. 

3. Select the luminaire(s), test period and, for Auto, the date and time.  

To abort a currently running test select the Test menu then Abort. 

4. After completion of a test select the Test menu then Collect. 

5. Select the luminaire(s) for which you want to collect test results. 

Interpreting Test Results 
The following table demonstrates the type of information obtained when test data is 
collected. 

=========================================================================== 
| Unit   | Volt  | Charge  |  Volt  |      Date        | Duration |  Test | 
|        |  at   |  rate   |   at   |       of         |    of    |  Out- | 
| Number | start |  Unit   | Cutoff |    Last Test     |   Test   |  come | 
=========================================================================== 
 D/0001    5.72     float     5.16        16/2/04          090       PASS 
 N/0002    5.76     float     5.24        16/2/04          090       PASS 
 ?/0003                                                         NOT FOUND 
 S/0004    8.88     float     8.88        16/2/04          001       LAMP 
 ?/0005    UNIT NOT YET COMMISSIONED   
 S/0006    8.96     float     8.16        16/2/04          090       PASS 
 D/0007    5.80     float     4.67        16/2/04          058       FAIL 
 D/0008    5.80     boost     5.42        16/2/04          120       PASS 
 N/0009    6.42     boost     5.78        16/2/04          090       PASS 
 S/0010    8.88     boost     8.04        16/2/04          090       PASS 

Unit Number: The luminaire number is preceded by either a ?, N, S or D.  

 A “?” means that communication was not established with the 
fitting. Refer to NOT FOUND and UNIT NOT YET 
COMMISSIONED below. 
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 An “N” means that the luminaire uses an incandescent lamp. 

 An “S” means that the luminaire monitors the light output from 
one lamp. 

 A “D” means that the luminaire monitors the light output from 2 
lamps. This is commonly used for a sustained Exit luminaire. 

Volt at Start: The battery voltage at the start of the test.  

Charge Rate Unit: This indicates if the batteries are being boost charged (boost 
charging lasts for 16 hours after the completion of a test) or float 
charged. 

Volt at Cutoff: This is the battery voltage when the test period is completed or  
when the luminaire turns itself off due to low battery voltage or a 
lamp fault before test completion (Fail  - see Test Outcome 
below). 

Volt at 90 Min: Not used in FMX system. 

Volt at 120 Min: Not used in FMX system. 

Duration of Test: The period that the test lasted. If the luminaire passed the test 
then it indicates the set test period. If the luminaire failed the test 
then it indicates the period before the luminaire turned itself off 
due to low battery voltage or a lamp fault. 

Test Outcome: PASS:  The luminaire functioned correctly for the set test 
period. 

 FAIL: The luminaire turned itself off before the end of the 
set test period due to low battery voltage. 

 LAMP: Indicates a faulty emergency lamp. 

NOT FOUND: Communication was not established with the fitting. There may 
be a fault with the fitting or interference on the building wiring. 
Check that the ITUs are functioning correctly and that the circuit 
breakers are on. If this occurs try increasing the number of retries. 
If communication still cannot be established contact Famco. 

UNIT NOT YET 
COMMISSIONED: The fitting has not been learned by the SCU. Run a learn routine 

for the fitting. 
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Logging Data 
The logging data facility allows the user to store in a file (file type ‘.log’) the data that 
is sent to the screen.  

Open the log file to which the data will be sent. From the File menu select Open Log. 

Enter the file details (name and directory) and select OK. The file name will be 
displayed at the right hand end of the Toolbar next to the logging control buttons. This 
box will display ‘Closed’ when there is not a file open for data logging. 

The file will now be in data logging mode - all information that is sent to the screen 
for display will also be stored in this file. In the Toolbar the  will be depressed 
indicating that the file is logging data. 

To interrupt data logging press the  button. 

To restart data logging press the  button. 

To close the logging file press the  button or select Close Log from the File menu. 

To view or edit a data logging file open the File menu and select Open. The editing 
commands from the Edit menu can be used for editing the data. Use the Save 
command to save the file and the Close command to close the file. 
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Site Information 
 

 

Site Name  

Site Address  

  

  

  

SCU Type  

SCU Telephone Number  

Installation Date  

Commissioned by  

Approved by  

Serial Number  

 


